Paycheck What If Calculator

User Guide

For Microsoft Dynamics® GP Version 2015 or 2016
Copyright

Manual copyright 2014 Integrity Data. All rights reserved.

Limitation of Liability

The content of this manual is furnished for informational use only, is subject to change without notice and should not be construed as a commitment by Integrity Data. Integrity Data assumes no responsibility or liability for any errors or inaccuracies that may appear in this manual. Neither Integrity Data nor anyone else who has been involved in the creation, production or delivery of this documentation shall be liable for any indirect, incidental, special, exemplary or consequential damage, including but not limited to any loss of anticipated profit or benefits, resulting from the use of this documentation or sample code.

Publication Date

May 2016
Contents

Introduction........................................................................................................................................4
Installation Overview..........................................................................................................................5
  Install Notes.......................................................................................................................................5
  Server/Client......................................................................................................................................5
Manual Install......................................................................................................................................11
Files Installed.....................................................................................................................................12
Registration.........................................................................................................................................13
  Activation Manager ..........................................................................................................................13
    Test and/or Historical Companies .................................................................................................14
  Version Information ..........................................................................................................................14
Security Settings...............................................................................................................................15
Utility Window...................................................................................................................................16
  Paycheck “What If” Calculator .........................................................................................................16
  Exclude Benefits Button ....................................................................................................................18
  Use Last Check Button .......................................................................................................................19
  Add to Batch Button ..........................................................................................................................19
  Calculate Button ...............................................................................................................................19
  “What If” Transaction Confirmation ...............................................................................................20
What If Activity....................................................................................................................................21
Payroll Data Scenarios.......................................................................................................................22
Gross Up Scenarios.............................................................................................................................23
Paycheck What If Calculator Messages.............................................................................................24
Activation Manager Messages............................................................................................................26
Deactivate Product ..............................................................................................................................27
  Disable.............................................................................................................................................27
  Inactivate .........................................................................................................................................27
  Uninstall ..........................................................................................................................................27
  Uninstall Activation Manager ...........................................................................................................28
Contact Information ..........................................................................................................................29
Introduction

Paycheck What If Calculator eliminates the need to change employee settings (and subsequent hassles if information is not returned to the correct settings) as well as the need to process a mock payroll by using Payroll "What If" Calculator. Increase employee satisfaction by printing easy to read reports that help employees and their families make important decisions regarding compensation.

When the user runs a payroll forecast the system creates a Calculate Checks Report based on set ups from the Paycheck ‘What If’ Calculator window. This simulation will not impact existing employee’s maintenance records and payroll data. The calculator will run one forecast for an employee at a time.

The user will have the ability to specify payroll data assumptions for a payroll forecast with the following information:

- **Pay Information**
  - Pay code
  - Hours
  - Rate
  - Begin Date
  - End Date
- **Tax Information**
  - Federal Filing Status
  - Federal Exemptions
  - State
  - Dependents
- **Deduction Information**
  - Deduction Code
  - Percent or Fixed Amount
- **Exclude Benefits**
Installation Overview

This section will discuss the prerequisites, list the files installed and go through the install process.

Install Notes

Prior to installing complete the steps:

- Confirm all users are logged out of Microsoft Dynamics GP
- Complete all payroll runs and validate no payroll runs are in process
- Make a backup of the Company and Dynamics databases

Paycheck What If Calculator will not impact the Paid-Time Office Manager product.

Server/Client

To install Paycheck What If Calculator downloaded the exe file from our website. Once the files have been downloaded, you can run them on the Server and/or Client Installations. The product will need to be installed on all machines that process payroll. If you will send with using Microsoft Outlook then download the Outlook Setup.exe in addition to the Integrity GP 2015 or 2016 Setup.exe

Complete the steps required at the Server and/or Client level to create the necessary Microsoft SQL Server® Components. Creating the Microsoft SQL Server Components needs to be performed on a single computer, typically the server.

1. Right click Integrity Data GP2015 or 2016 Setup.exe file and select “Run as Administrator”. If you do not see this option, hold the shift key down and right click.

2. Complete the steps in the wizard
3. Verify the GP directory is correct if it is not select Change
4. Select Custom to choose to install only the specific products you purchased.

5. Select Activation Components to only install activation manager files. This option will not install products and it is typically ran only to fix an error with activation manager.

6. Select All Components to install all Integrity Data products. The products you did not purchase will register with a 30-day trial period.
If you are upgrading you will be prompted to uninstall the older version, select “y”. If you have multiple products, it will uninstall all products.

7. **Select the product(s) to install, if installing multiple products, select all that need to be installed.**
Integrity Data GP 2015 Setup - InstallShield Wizard

Custom Setup
Select the program features you want installed.

Click on an icon in the list below to change how a feature is installed.

Feature Description
Enable payroll users to process hypothetical payroll calculations to determine what an employee's new net paycheck would be if a change is made to their pay, etc. This feature requires 3676KB on your hard drive.

Install to:
C:\Program Files (x86)\Microsoft Dynamics\GP2015\n
Ready to Install the Program
The wizard is ready to begin installation.

If you want to review or change any of your installation settings, click Back. Click Cancel to exit the wizard.

Current Settings:

Setup Type:
Custom

Destination Folder:
C:\Program Files (x86)\Microsoft Dynamics\GP2015\n
User Information:
Name: Windows User
Company:

9. If prompted to include new code, choose yes.

10. Login as the ‘system administrator’ for each company to create the SQL Server components.

11. The system will auto activate the products you have purchased if you have access to the internet on the machine. If you receive a message Activation Manager failed contact support@integrity-data.com and include a screenshot of the Activation Manager window to receive manual keys.

**BEST PRACTICES**

| Install is not a requirement on the **Server**; however it is recommended. | Install updated version on previously installed **Client** machines. |
**Manual Install**

*If the user encounters errors during the installation, complete the following steps to manually install Paycheck What If Calculator:*

1. **Contact** [support@integrity-data.com](mailto:support@integrity-data.com) **to receive the manual install files for the product(s).**
2. **Copy and paste the files into the appropriate locations.**

   **GP Folder** *(C:\Program Files\Microsoft Dynamics\GP2015) or (C:\Program Files\Microsoft Dynamics\GP2016)*
   - PWC6759.cnk or PWC6759.dic
   - IDA6537.cnk
   - Integrity.Registration.Addin.dll
   - Application.IntegrityDataActivation.dll
   - Integrity.Registration.Constructor.dll

   **Documentation Folder** *(C:\Program Files\Microsoft Dynamics\GP2015\Documentation) or (C:\Program Files\Microsoft Dynamics\GP2016\Documentation)*
   - Paycheck What If Calculator User Guide.pdf

3. **Edit the Dynamics.exe.config**
   a. **Navigate to the GP folder** *(C:\Program Files\Microsoft Dynamics\GP2015)*
   b. **Backup the Dynamics.exe.config by making a copy and saving the copy**
   c. **Open Dynamics.exe.config in Notepad**
   d. **Find the <addin> and under <Dynamics> copy and paste the following:**
      ```xml
      <addin name="IDKeyManagerAddIn"
          type="Integrity.Registration.Addin.GPAddIn,Integrity.Registration.Addin,Version=14.0.5.20297,Culture=neutral,PublicKeyToken=b7ed37edf026e3bc"/>
      ```
   d. **Under <DynamicsGPweb> copy and paste the following:**
      ```xml
      <addin name="IDKeyManagerAddIn"
          type="Integrity.Registration.Addin.GPAddIn,Integrity.Registration.Addin,Version=14.0.5.20297,Culture=neutral,PublicKeyToken=b7ed37edf026e3bc"/>
      ```
4. Launch Microsoft Dynamics GP.
5. Login as the 'system administrator' for each company to create the SQL Server components.

Files Installed

The files installed for Paycheck What If Calculator is:

GP Folder (C:\Program Files\Microsoft Dynamics\GP2015) or (C:\Program Files\Microsoft Dynamics\GP2016)

- PWC6759.cnk or PWC6759.dic
- IDA6537.cnk
- Integrity.Registration.Addin.dll
- Application.IntegrityDataActivation.dll
- Integrity.Registration.Constructor.dll

Documentation Folder (C:\Program Files\Microsoft Dynamics\GP2015\Documentation) or (C:\Program Files\Microsoft Dynamics\GP2016\Documentation)

- Paycheck What If Calculator User Guide.pdf
**Registration**

The system will automatically activate the product during the login process. If the activation was successful, the user will not receive any messages. However, if the activation process was unsuccessful the user will receive a message. If the activation process fails the user will need to open the Activation Manager window to activate the product.

**Activation Manager**

*Microsoft Dynamics GP > Tools > Setup > System > Activation Manager*

The Site Name defaults from the session information on the About Microsoft Dynamics GP window.

From the Product drop-down list the user may select the product they wish to activate and review product information. Once the product is selected the following fields will display:

- **Installed Version** – Current version number installed.
- **Enhancement Plan Date** – Date of the enhancement plan expiration.
- **Activation Status** – Current status of the product.
  - Permanent – Product has been purchased.
  - Trial – Product has been issued a trial period.
  - Deactivated – Product has been deactivated.
- **Current Employees** – This count defaults from the session information on the About Microsoft Dynamics GP window. The count does not include inactive employees or employees in a Test or
Historical company. If the current employee count is incorrect validate Test or Historical companies are named correctly.

- **Employees Allowed** – The number of employees allowed before the product will be inactivated. If the Current Employees exceeds the Employees Allowed the system will deactivate the product.

The scrolling window contains a list of all companies. By default the product is active for all companies. If the user would like to inactivate a company unmark the company checkbox.

The Auto Activation option may be selected if the user receives a message at login stating the product is not activated. When the user selects the Auto Activation option the system will attempt to automatically activate the product. Once the Auto Activation process is complete the system will display the Activation Messages. For a detailed list of activation messages see the Activation Manager Messages section.

The Manual Activation option is used to manually enter a token. The user would only manually enter a token if they were sent a token by Integrity Data.

Select the OK button to close the window.

**Test and/or Historical Companies**

Registration will not count the active employees in Test or Historical company databases if the Company Name is named correctly, specifically at the end of the Company Name the user must append the following: “<TEST>” or “<HISTORICAL>”. See examples below:

- Dextordinary, Inc. <TEST>
- Dextordinary, Inc. <HISTORICAL>

To access and modify the Company Name open the Company Setup window via Microsoft Dynamics GP > Tools > Setup > Company > Company when logged into the Test or Historical Company that needs modified.

**Version Information**

To obtain the latest Paycheck What If Calculator version information, visit our website.

Within Microsoft Dynamics GP verify the version for Paycheck What If Calculator by selecting the Help Button, select About Microsoft Dynamics GP and then select the Options button. Click OK until the Paycheck What If Calculator window appears.
Security Settings

The Security Task Setup window may be used to grant or restrict access to the Paycheck What If Calculator windows. To open the window, select the Microsoft Dynamics GP menu, select Tools, select Setup, select System, select Security Tasks and enter the system password.

1. Select the appropriate Task items. To identify the appropriate task item complete the steps below:
   - Open the User Security Setup window (Microsoft Dynamics GP > Tools > Setup > User Security), select the appropriate user and make a note of the Security Role ID assigned to the user.
   - Open the Security Role Setup window (Microsoft Dynamics GP > Tools > Setup > Security Roles), select the Role ID that has been assigned to the user and make note of the Security Task ID assigned to the Role. Use this Task ID to grant security to the Paycheck What If Calculator.
     NOTE: The most common Task ID used is TRX_PAYRL_004 – Print Payroll Checks

2. Select Paycheck What If Calculator for the Product.

3. Select Windows for the Type and select 3rd Party for the Series.

4. Use the Access List to grant or restrict access to individual items.
   - To grant or restrict access to an item for this Task ID, click the checkbox to mark or unmark the item.
   - Click the Mark All button to grant access to all items in the list or click the Unmark All button to restrict access to all items in the list.

5. Click File > Print to print the Security Task Setup Report for the selected Task ID.

6. Choose OK to save your changes.

Paycheck What If Calculator > Windows > 3rd Party > Access List

- APR Main Menu
- Paycheck ‘What If’ Calculator
Utility Window

Paycheck ‘What If’ Calculator

Microsoft Dynamics GP > Tools > Utilities > Payroll > Paycheck ‘What If’ Calculator
Cards > Payroll > Employee > Goto > Payroll > Paycheck “What If” Calculator

The Paycheck ‘What If’ Calculator window allows the user to process paycheck estimates for employees by defining assumptions and from existing payroll data.
**Employee ID** – If the user accessed the Paycheck “What If” Calculator window from Employee Maintenance then this field will display the employee ID of the employee which was selected at the time it was accessed. Otherwise this field is empty and you must select an employee ID by typing the ID or use the lookup button to select an ID.

**Name** – Displays the name of the employee whose employee ID is selected in the Employee ID field.

**Mass Gross Up** – Check this option to run gross up calculations for multiple employees.

**Batch ID** – Enter the payroll batch to add what if transaction. When the system calculates the “what if” scenario if the user selects Add To Batch button then the system will add the payroll transaction to the batch selected in the Batch ID field.

**Batch Comment** – Displays the batch comment.

### Pay Information

The Pay Information section displays the selected employee’s pay code information.

**Include** – system will mark the Include checkbox for the primary pay code and the first salary pay code listed. The pay codes marked will be included in the forecast.

**Code** – system will default the active pay codes with the type of salary and hourly into the scrolling window assigned to the employee. Additional pay codes not assigned to the employee may be included in the pay information scrolling window used for calculating.

**Hours** – will default from the employee pay code maintenance or the pay code setup records for the selected pay code.

- If the user attempts to enter hours for a salary pay code, the system will prompt message: **This code is a salary code. You cannot edit this field.**

The following fields default with the appropriate information from the employee pay code maintenance or pay code setup records:

- Rate
- Begin Date
- End Date
- Pay Type
- Unit of Pay
- Pay Period

**Gross Up** – when a pay code is marked as Gross Up the system will:

- Unmark all other pay codes as Include.
- Prevent the user from marking other pay codes as Gross Up and the system will prompt: **You cannot mark this code as gross up while another code is marked.**
- If the user checks Gross Up for a pay code other than type Commission or Other, the system will prompt message: **Only pay codes of type Commission or Other can be marked for Gross Up.**

### Tax Information

Within the Tax Information section, the system defaults the tax information for the select employee. The user may adjust the following tax information for the select employee:

- Federal Tax Withholding
- State Tax Withholding
- Personal Exemptions
Deduction Information
The Deduction Information scrolling window defaults all active deduction codes assigned to the employee in the employee deduction maintenance record(s). Additional deductions not assigned to the employee may be included in the calculation.

Include – user may mark this checkbox to include the Deduction in the forecast.

Code – defaults the code from the employee deduction maintenance record or the deductions setup window.

Percent – user may enter a percentage, if the deduction is setup as a percent in deduction maintenance or deduction setup records. If a user attempts to enter an amount, the system will prompt: **You cannot enter a fixed amount for a percent deduction.**

Amount – user may enter a dollar amount, if deduction is setup as a fixed amount in deduction maintenance or deduction setup records. If a user attempts to enter a percentage, the system will prompt message: **You cannot enter a percent for a fixed amount deduction.**

Gross Up – when marked the system will adjust the gross up amount such that the net pay for the pay code gross up is unaffected by this deduction. When Gross Up is unmarked, the system will adjust the net pay to reflect the amount of the deduction.

Exclude Benefits Button
The Exclude Benefits Button will open the 'What if’ Check Benefits window. The system will set as excluded, all benefits available.
Use Last Check Button
The Use Last Check Button will clear and repopulate the window with the following data from the last non-voided pay check in payroll transaction history for the employee selected:

Pay Information
- The system will include the pay codes used in the creation of the last check in the scrolling window excluding any Reallocate, Reduce or Additional Amount transactions for pay codes of type salary.
- The system will mark the codes displayed include.

Deduction Information
- The system will include the deduction codes used in the creation of the last non-voided check in the scrolling window.
- The system will mark the codes displayed as include.

For a specific forecast, the system will retain the currently selected Employee ID, Employee Name and the corresponding Tax Information during the repopulate event of Use Last Check button.

Exclude Benefits
The system will set as excluded, all benefits available to the employee which were not included in the last non-voided check.

- Clear – When pressed the system will clear all fields on the payroll forecast window.
- OK – Closes the Payroll Forecast window.

Add to Batch Button
Select the Add to Batch button to add the transactions from the “What If” Transaction Confirmation window to the Batch ID selected.

Calculate Button
When the calculate button is selected the system will run payroll forecast process. If the included deduction is based on Percent of Gross Wages and the percent entered in the Percent field is greater than 100%, the user will be prompted: Deductions marked as Gross Up exceed wage amount. Cannot continue.
“What If” Transaction Confirmation

The Preview Transactions Button will open the “What If” Transaction Confirmation window. This option will be available after calculating a “What If” scenario. The “What If” Transaction Confirmation window will display the transactions that will be added to the Batch ID specified.
What If Activity

Microsoft Dynamics GP > Tools > Utilities > Payroll > Paycheck What If Activity

The What If Activity window allows the user to remove in process what if calculations. This process does not need to be run regularly, it is typically only run if a batch fails or you unexpectedly receive an error message. Should you have a need to use this functionality and have questions about the records to remove please contact support@integrity-data.com.
Payroll Data Scenarios

Fabrikam managers are often asked payroll question by their employees when a life changing event occurs such as a position change, marriage or child birth or a change in deduction amounts.

So “What If” there is a change to Pay Information…

Fabrikam has a motivated employee who is considering working extra hours and adopting the swing shift. Before deciding to take the position, she asks her manager to run a simulation using the new wage she would receive.

The manager pulls Pilar’s information into the Paycheck ‘What If Calculator‘ window and adjusts the pay code to reflect the swing shift rate and the hours to reflect the additional hours she would work.

Once the calculation is run Pilar can see the impact earning more money would make on the bottom line assuming all other factors remained constant.

So “What If” there is a change to Tax Information…

Pilar Ackerman recently got married and has also elected to change her Federal exemptions on her taxes due to a second income in the family.

The Fabrikam payroll manager opens the Paycheck ‘What If Calculator’ window and elects to retrieve Pilar’s latest check information by clicking the Use Last Check button. Once the information is populated the payroll clerk changes the Federal Filing Status to Married and the Federal exemptions to 2.

Once the calculation has run the payroll clerk, can provide Pilar with the Calculate Checks Report can see the impact these changes would have to her check.

So “What If” there is a change to the Deduction Information…

Pilar has now been employed at Fabrikam long enough to be eligible to participate in the 401K plan. Selecting the right amount to contribute will depend on what happens to her check when she starts participating.

She therefore asks her manager to run a “What if” Calculation using her information from her last pay check, but this time to include the 401k deduction which she currently doesn’t participate in. Now Pilar can experiment with different percentage levels of a 401k deduction before committing to a plan amount.
Gross Up Scenarios

Fabrikam payroll department is often asked to calculate the gross up for bonus, gift or pay increase by management.

Pay Information...

Pilar Ackerman is to receive a bonus due to exceeding sales goals at Fabrikam. The bonus system requires that Pilar net $3,500 on the check. Her manager however needs to know what this will translate to in gross terms so as to accurately plan funds.

The manager opens the Paycheck ‘What If Calculator’ window and enters the bonus code into the Pay information section and sets the rate to $3,500. She makes sure to mark the code as Gross Up in the far right column.

Now when the system calculates the simulation, the manager will know what gross amount to set the bonus check for during payroll processing.

Deduction Information...

Pilar’s manager forgot that even bonus check is subject to the health insurance deduction of $100. So she must include it in the Deduction Information section of the What If Calculator. This would unfortunately cause the net amount of the check to be $3,400.

To prevent this from happening to the net amount the manager must also mark the deduction as Gross Up so that the system will adjust the gross pay to end up netting Pilar the $3,500 even after her deduction.
Paycheck What If Calculator Messages

A payroll Forecast cannot be run when the system is actively processing a Forecast.
**Situation:** The user is actively calculating a forecast.

**Solution:** Validate no other forecast is calculating.

You cannot mark this code as Gross Up while another code is marked.
**Situation:** The user attempted to mark a pay code as gross up while another pay code was already marked.

**Solution:** The user needs to validate the correct pay code is marked as gross up.

This code is a salary code. You cannot edit this field.
**Situation:** The user attempted to edit the Hours field for the salary pay code.

**Solution:** Since the pay code is salary the Hours field cannot be edited.

You cannot enter a fixed amount for a percent deduction.
**Situation:** The user attempted to enter a value in the fixed amount field when the deduction was percent.

**Solution:** The user needs to validate which field the edit is needed.

You cannot enter a percent for a fixed amount deduction.
**Situation:** The user attempted to enter a value in the percent field when the deduction was fixed amount.

**Solution:** The user needs to validate which field the edit is needed.

Only pay codes of type Commission or Other can be marked for Gross Up.
**Situation:** The user attempted to mark Gross Up for a pay code not a pay type of Commission or Other.

**Solution:** The user needs to validate the pay code being selected for Gross Up.

You cannot include this Pay Code since there is a Gross Up record included.
**Situation:** The user attempt to mark another pay code as Include when a pay code is already marked Included and Gross Up.

**Solution:** Validate the correct pay code is marked as Gross Up.

You cannot mark a deduction as Gross Up when the deduction is method of “Percent of net wages.”
**Situation:** The user attempted to check a deduction as Gross Up when the deduction method is “Percent of net wages”.

**Solution:** The user needs to validate the deduction method for the deduction code.

A pay code must be marked as Gross Up before a deduction may be marked as Gross Up.
**Situation:** The user attempted to check a deduction as Gross Up when a pay code has not been marked as Gross Up.

**Solution:** The user needs to mark a Pay Code as Gross Up and then mark a deduction as Gross Up.
Deductions marked as Gross Up exceed wage amount. Cannot continue.

Situation: The user marked a Percent of Gross Wages deduction as included and the percent entered in the Percent field is greater than 100%.

Solution: The user needs to validate the percent entered in the Percent field.
Activation Manager Messages

Activation Failed: Trial invalid or trial period expired
Situation: The trial period has expired for the product.
Solution: Contact sales@integrity-data.com and request additional trial period or purchase the product.

Activation Failed: Site name does not match this installation
Situation: The site name does not match the token which was issued.
Solution: Send support@integrity-data.com a screenshot of the Activation Manager window with the error message displayed so the token can be updated with the correct site name.

Activation Failed: Product Name does not match this installation
Situation: The product name does not match the token which was issued for a product.
Solution: Send support@integrity-data.com a screenshot of the Activation Manager window with the error message displayed so the token can be updated with the correct site name.

Trial period for Paycheck What If Calculator has expired
Situation: The trial period has expired for the product.
Solution: Contact sales@integrity-data.com and request additional trial period or purchase the product.

Employees Allowed has been exceeded
Situation: The current employee count has exceeded the employees allowed.
Solution: Contact sales@integrity-data.com to upgrade to the next tier.

Activation Failed: Unable to contact web service. Activate manually or revert to previous product dictionary
Situation: The system could not make a connection to the web service.
Solution: Contact support@integrity-data.com for assistance.

Activation Failed: Product has been deactivated
Situation: The product has been deactivated.
Solution: Contact support@integrity-data.com for assistance.

Upgrade Failed: Enhancement Plan period expired. Renew Enhancement Plan or revert to previous product version.
Situation: User attempted to upgrade a product when their enhancement plan was expired.
Solution: Contact sales@integrity-data.com to renew the enhancement plan.

Paycheck What If Calculator: Activation Failed
Situation: Communication breakdown between the user machine and Integrity Data.
Solution: Contact support@integrity-data.com for assistance.
Deactivate Product

There are three ways to deactivate the Paycheck What If Calculator; disable, inactive or uninstall.

Disable
To disable Paycheck What If Calculator without having to exit Microsoft Dynamics GP, open the Customization Status window. To open this window, select the Microsoft Dynamics GP menu, point to Tools, select Customize and then click Customization Status. Select the product from the list and click Disable. The product can be enabled by closing and reopening Microsoft Dynamics GP.

Inactivate
Paycheck What If Calculator can be inactivated by company, open the Activation Manager window and unmark the company checkbox.

Uninstall
If Paycheck What If Calculator needs to be uninstalled complete these steps on the server and the client where Paycheck What If Calculator has been installed.

1. Remove the PWC6759.DIC file from the Runtime Directory
   Default location is C:\Program Files\Microsoft Dynamics\GP2015 or C:\Program Files\Microsoft Dynamics\GP2016

2. Make a copy of the Dynamics.set file

3. Open the Dynamics.set file
   a. Decrease the top number by one:
      For example, if the top number is 21 change it to 20
   b. Remove the following lines from the Dynamics.set file:
      6759
      Paycheck What If Calculator
      :C:Program Files/Microsoft Dynamics/GP/PWC6759.DIC
      :C:Program Files/Microsoft Dynamics/GP/Data/PWC6759F.DIC
      :C:Program Files/Microsoft Dynamics/GP/Data/PWC6759R.DIC

4. Save the Dynamics.set file

5. Launch Microsoft Dynamics GP and login as the ‘system administrator’
Uninstall Activation Manager

Activation Manager will manage activation for all Integrity Data Products. If you are uninstalling all Integrity Data products, you need to remove the Activation components.

**IMPORTANT:** If you uninstall one product but have other Integrity Data products do not uninstall the Activation Manager components.

1. **Make a copy of the Dynamics.set file**
2. **Open the Dynamics.set file**
   a. Decrease the top number by one:
      For example, if the top number is 21 change it to 20
   b. **Remove the following lines from the Dynamics.set file:**

      ```
      6537
      Integrity Data Activation
      :C:Program Files (x86)/Microsoft Dynamics/GP2013/IDA6537.DIC
      :C:Program Files (x86)/Microsoft Dynamics/GP2013/Data/IDA6537F.DIC
      :C:Program Files (x86)/Microsoft Dynamics/GP2013/Data/IDA6537R.DIC
      ```
1. **Save the Dynamics.set file**

Make a copy of the Dynamics.exe.config file.

3. **Edit Dynamics.exe.config and find the line(s) beginning with:**

   ```
   <addin name="IDKeyManagerAddin"
   ```
4. **Remove the lines from both the <Dynamics> and <DynamicsGPWeb> sections.**
5. **Save the Dynamics.exe.config file**
6. **Launch Microsoft Dynamics GP and login as the 'system administrator’**


Contact Information

Get quick answers to your questions

Browse our convenient Knowledge Base for up-to-date answers to the most common questions. For additional questions, please contact your authorized Value Added Reseller (VAR) for support on this product (if you have one) or contact Integrity Data by emailing support@integrity-data.com or calling 888.786.6162.

If you have registered your product, Technical Customer Service is available for any customers with a current Enhancement Plan or subscription. Please have your Company or Site Name available. Your first line of support should always be your VAR (if you have one).

Join our User Groups

We have an HR and payroll focused one and an ACA one – email lbelley@integrity-data.com to join!

Rate us and our products

Are you pleased with your experience with us and our products? Provide a quote and get a gift card! Fill out the form on our contact page and leave your quote in the comment section.

Suggest new features or improvements

User input into improving this product and constructive feedback are appreciated. Please e-mail Tom, our Product Manager, at tfranz@integrity-data.com. As always, technical ideas and user input are highly encouraged. At Integrity Data, we want to hear your input, so drop us a line!

Browse our solutions

The Integrity Data website is a great place to get additional information on products and services. The following information is available on our website:

- Integrity Data’s HR & Payroll software pages include Demos, Features and Benefits, and ROI Calculators
- Visit our Services page to learn more about our additional customization services

If you would like to discuss your needs with a Sales Account Executive, please call 888.786.6162 or e-mail sales@integrity-data.com.